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Micro Focus Academic Program 2.3 Update
1 - Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Overview
The Micro Focus Academic Program brings contemporary software development tools and technologies to
COBOL development helping to bridge the gap between the old and the new.
COBOL applications still run many of the world’s business systems, therefore teaching the COBOL
language is a great way to prepare your university's students for a robust IT career in today’s economy.
The Micro Focus Academic Program is designed to support the education and use of the COBOL language
within the academic setting. This program supports our academic partner community through the use of
our COBOL development tools and materials within the classroom.
This program will enable your university to quickly join this growing league of similar academic
organizations in support of the promotion and education of the COBOL language.
Welcome! We’re excited to have you join our growing academic community.
Product Description
The Micro Focus Academic Program Edition package comprises the following products:
•

Visual COBOL - delivers the richest development experience for COBOL programming. On Windows,
Visual COBOL is available for use with Microsoft's Visual Studio or with the Eclipse integrated
development environments. On UNIX or Linux, it is available for use with Eclipse. Visual COBOL
supports the development and deployment of both JVM COBOL and .NET COBOL, and of native
COBOL applications.
Variants of Visual COBOL include:

•

• Visual COBOL for Visual Studio 2012, Visual Studio 2013 or Visual Studio 2015
• Visual COBOL for Eclipse (Windows)
Enterprise Developer - a contemporary development suite for Microsoft Visual Studio or for Eclipse that
enables mainframe developers to maintain, develop and modernize mainframe applications regardless
of whether these are to be deployed back on the mainframe or onto an alternative platform. Enterprise
Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM DB2,
IBM z/OS file formats and common batch utilities including SORT. This means you can develop and
maintain the core mainframe online and batch applications under Enterprise Developer, then deploy
them back on the mainframe or migrate them onto one of the Micro Focus production platforms
available on UNIX, Linux, or Windows. Variants include:
•
•

Enterprise Developer for Visual Studio 2012, Visual Studio 2013 or Visual Studio 2015
Enterprise Developer for Eclipse

Micro Focus Academic Program differs from the full version of these products in a number of ways. The
differences are:
•
•

4

You cannot deploy applications on other machines, so Micro Focus COBOL Server and Enterprise
Server are not supplied.
An authorization code for the Micro Focus Rumba 3270 terminal emulator is not supplied.
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Note: Micro Focus Academic Program is supplied for Academic use only. It is not to be used for any
commercial purposes. You must be a registered Micro Focus Academic Program Partner in order to
use this software.
For more information, follow the link in the Electronic Product Delivery email for the End User License
Agreement.
Reporting Issues
•

For the latest information and discussions on this product, or to report issues, visit the Micro Focus
Community Web site.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•

AppMaster Builder
Communications Server
Data Tools
Dialog System
Editor Writing Assistance
Enterprise Server
IBM Language Environment for OS/390 & VM Support
IDE
JCL Support
Run-Time System

AppMaster Builder
Back to the list
•

A new checkbox, "Use File Tailoring for Dataview generation", has now been added to the Database
View dialog box in the AppMaster Builder (AMB) preferences. When checked, the Database Views will
be generated using File Tailoring files and the AMB Builder Server.
2820090 (1099354)

Communications Server
Back to the list
•

A new option, [Operation] synchronous=yes (or 1, or Yes, or y or Y) is now supported in the
Fileshare listener configuration.
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Data Tools
Back to the list
•
•
•
•

When filtering a data file, if there is no valid temporary directory set, you are prompted to set one using
the option in the Preferences dialog box.
The editor no longer allows you to open a file if the file size (without header size) is not a multiple of the
record size on disk; an error is produced instead.
The editor no longer allows you to open a file if the file size without header size is not a multiple of the
record size on disk; an error is produced instead.
The level numbers displayed in a record layout correspond to the levels used in the .idy file that was
used when the structure file was created.

Dialog System
Back to the list
•

Versions of the Micro Focus Compatibility AddPack released with version 2.3 of Enterprise Developer or
Visual COBOL 2.3 or with earlier versions supported the use of the "MFOLECL_NO_THREAD_INIT"
environment variable. Using this variable, you could disable the default OLE Class Library COM
threading initialization. This helped avoid issues that could manifest as hangs and crashes, especially
on Microsoft's Windows 8.x or 10 and with applications that are a hybrid between Dialog System, OLE
class library and .NET elements - see http://community.microfocus.com/microfocus/cobol/
visual_cobol/w/knowledge_base/20715.exception-occurs-when-native-dialog-system-program-callsmanaged-winform.aspx.
In the version of the Micro Focus Compatibility AddPack released with Enterprise Developer 2.3.1 or
Visual COBOL 2.3.1, this environment variable is now enabled by default and no longer needs to be set
exclusively. To restore the previous behavior, use a new environment variable,
MFOLECL_THREAD_INIT, and set it to Yes.
2848875 (1102920)

Editor Writing Assistance
Back to the list
•
•

IntelliSense (Visual Studio) or Content Assist (Eclipse) suggestions are no longer offered if you start
typing numbers and automatic triggering of suggestions is enabled.
Pressing TAB in the Visual Studio editor now always inserts the highlighted item in the IntelliSense list
of suggestions.

Enterprise Server
Back to the list
•

•

In situations where the crossregion option of the shareoptions parameter is either 1 or 2, both a CICS
and a JCL job could have the same file open for IO. This has been fixed. In addition, the '-oo' (and the
synonymous '-o ') option of the casfile command has been deprecated. If '-oo' is used, you will now
receive a return code 4 (warning). Instead of '-oo', you need to use the '-ooi' option (open immediate). If
-oo is used with a region configured for VSAM shareoption use, the '-ooi' option is now forced.
2839272 (1101672)
When using an external security manager to secure a region, the EXEC CICS START TRANSID API
now works as expected and honors the USERID option. Previously, the started transaction would run
under the authority of the user that executed the EXEC CICS START API.
2835112 (1101201)

IBM Language Environment for OS/390 & VM Support
Back to the list

6
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•

When calling SETENV, SYSOUT(?) can be specified. This designates the file as a spool file but will not
update its CLASS.
2841220 (1101955)

IDE
Back to the list
•

•

When compiling to multiple executables from the command line, you must specify the -logger parameter
to enable the correct log to be output to the console.
2848855 (1102932)
For a file added to a JVM COBOL project by adding the folder that stores the file (using the Source tab
on the Micro Focus > JVM Build Path > Source page in the projects' properties), there is now a new
context-menu command, Copy to Output Directory, in COBOL Explorer. Choosing this command on a
file triggers a build of the project and copies the file into the output directory.
2699374 (1094326)

JCL Support
Back to the list
•

•

•

•

The return code from a JCL printer exit will now be checked. If it is non-zero, the dataset that was sent
to the printer exit will be moved to the OUT-HOLD queue rather than to the PRINTED queue. To release
the dataset, click "Release" in the ESMAC view - this will also present the dataset again to the printer
exit.
2834206 (1101079)
Under Enterprise Server and Enterprise Server for .NET, flushing an active job previously resulted in all
associated spool records for the job being deleted, but left the job running. A subsequent attempt to kill
the running job using casout/seeout failed due to the job spool record no longer existing. This change
causes the flush request to fail if the job is active. You must kill the active job first before attempting to
flush it.
The catalog search facility has been enhanced to provide a quicker return when using wildcards in the
dataset name selection.
2698700 (1094266)
REXX can now be executed in VSE via IKJEFT01 and IRXJCL using in-stream data.
2831984 (1100883)

Run-Time System
Back to the list
•

The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT’ API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.
If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.
To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file:
mfaudit.timeout = n
Where n is the timeout value in milliseconds.
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To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET’ API. It takes an integer property-value, which should be the
timeout value in milliseconds.
If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
‘CBL_AUDIT_CONFIG_PROPERTY_GET’ API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.
•

2838689 (1101685)
Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE
class condition tests:
•

IS [NOT] DBCS

•

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through 0xFE, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.
IS [NOT] KANJI

•

When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through 0x7F, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kanji character, and returns true if valid.
IS [NOT] JAPANESE
When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.
When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCH0303 Operand has wrong data-type message on compilation.

2812895 (1098401)

Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
Compiler
•

In .NET projects that include multiple COBOL programs, the following sequence of programs can cause
the Compiler to crash:
•
•
•

one or more programs that use COBOL file handling;
a program that does a platform invoke to a native COBOL program;
another program that also uses file handling.

Debugging
•

8

When debugging a remote program, the performance of the network, specifically the latency between
the local and remote machines, will have an effect on the responsiveness of Eclipse. Whenever Eclipse
has to show the new execution position, a number of messages are sent from the remote machine, over
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the network, to get the required information. The effect of this is that it can take a few seconds after a
Step command is issued before Eclipse has updated the screen and is ready for the next command.

•

You can mitigate this delay by closing any unnecessary debug views. For instance, by closing the
Expressions view and the Variables view, the number of messages that are sent is reduced, which
allows Eclipse to update quicker.
Large programs can suffer from a large delay the first time that the program is displayed in the debugger
and an expression is evaluated. You can reduce this delay by following these steps:
1. Create a text file called debugconfig.xml.
2. Add the following lines, and then save the file:

•
•

<?xml version="1.0" encoding="utf-8" ?>
<NativeDebuggerOptions>
<DebugOption Option="REMOTECHECKER" Value="yes"/>
</NativeDebuggerOptions>
3. At a command or shell prompt, set the environment variable DEBUG_CONFIG to the full path name
for debugconfig.xml.
4. Start Eclipse from the same command or shell prompt.
Remote debugging does not work for programs running on AIX or HP machines, if you are trying to
debug using Visual COBOL installed on a Linux machine.
When debugging Object COBOL programs, it is not possible to step into methods if the Visual Studio
Autos window is enabled.

Documentation
•

A known issue in JRE 1.7.0_45 (issue JDK-8028111) causes problems with searching and indexing the
help in the Eclipse help viewer if you are running Eclipse on a machine that has this version of JRE
installed.

Database Access
•

If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual COBOL or HCO for
DB2 LUW in Enterprise Developer and the DB2 software is not installed on the client machine where
you are using the Eclipse IDE, you receive background parsing errors in your application. To resolve the
issue, you can do either one of the following:
•
•

Disable background parsing Window > Preferences > Micro Focus > COBOL > Editor and
disabling the checkbox for Background parsing.
Install the IBM DB2 client-side software on the machine on which you are running Eclipse. Go to the
IBM Support Home and locate the page entitled "IBM Download Fix Packs for IBM Data Server
Client Packages" .

Enterprise Server
•
•

•

The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.
In Visual COBOL 2.3, some job scheduling tools from third-party vendors might stop communicating
with Enterprise Server. This might have an impact on our external partners who integrate with
Enterprise Server such as job schedulers which do not use MFBSI. The issue might occur with job
schedulers such as Zena, CA, ASG or UC4, if these are run outside of a COBOL environment with the
path set. Click here for more information about the issue and how to work around it.
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IDE
•

If you are upgrading your license from Visual COBOL for Eclipse Personal Edition (v2.2 or earlier) to
Visual COBOL, or from Visual COBOL Connect (v2.2.1 or later) to Visual COBOL, any existing projects
compiled to either .exe or .dll files using the old license must be updated in order to recreate
the .cobolBuild file. You can do this done by adding or removing files from the project or by deleting
the .cobolBuild file. Updating the project in this way ensures Eclipse will fully build the executable
files.

•

When you add a COPY statement in a COBOL program and then show it in Expanded Copybook View,
the line for the copybook statement is read-only. If you then perform an Undo in the COBOL program,
the COPY statement is removed while the contents of the copybook is still shown in the program.
Replace All does not work inside the Expanded Copybook View
For copybooks with file extensions that are not traditionally associated with COBOL you must first add
the file extension to the list of known copybooks extensions in Tools > Options > Text Editor > File
Extensions before you can show them in Expanded Copybook View.

•
•

Linking
•

Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C
object code built with that version of Visual Studio in the same executable. In this scenario, you must
use the Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro
Focus cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might
also need to specify some additional C runtime libraries - see the Microsoft documentation for more
details.
Note that when using COBOL and C object code together, Micro Focus recommends you build and
keep the COBOL and C executables separate, and use import libraries and the Micro Focus C functions
for calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between
them.

Micro Focus Rumba
•

On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address
(127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as Micro Focus
Rumba may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference
to localhost or your host machine's name.

PL/I Support
•

•

The Micro Focus PL/I Macro Preprocessor supports the majority of the IBM PP(MACRO) functions. The
only support for PP(PLX) is for the deprecated KEYS option. There are no plans to further extend the
existing support for PLX.
Trying to debug remote PL/I projects that compile to 32-bit using the CodeWatch debugger fails. To work
around this issue, you must set the environment variable $COBMODE to COBMODE=32 on the remote
machine before you start the RDO daemon.

Resource Adapters
•

10

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).
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REST/JSON IMTK implementation and the same-origin policy (SOP)
•

HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

Installation
System Requirements
Hardware Requirements
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.
Visual COBOL and Enterprise Developer for Visual Studio
Visual COBOL and Enterprise Developer have the following requirements in addition to the requirements of
Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.
The disk space requirements are:
Product

Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL

1.2GB

75MB

Enterprise DeveloperEnterprise
Developer

2.3GB

75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.
Visual COBOL and Enterprise Developer for Eclipse on Windows
The disk space requirements are:
Product

Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL

3.7GB

75MB

Enterprise Developer

4.5GB

75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: If you are using Visual COBOL or Enterprise Developer on a 64-bit operating system, you can
produce either 32-bit or 64-bit applications.
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For a list of the operating systems each individual product in this package supports, check the Product
Availability section on the Micro Focus SupportLine Web site: http://supportline.microfocus.com/
prodavail.aspx.
•

Visual COBOL for Visual Studio is not supported on versions of Windows earlier than Windows 7.

Software Requirements
Note: This product includes OpenSSL version 1.0.1p.

Windows
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
Visual COBOL and Enterprise Developer for Visual Studio:
This product requires Microsoft's Visual Studio - either the Visual Studio Integrated Shell or a more
advanced version of Visual Studio.
The following advanced editions of Visual Studio are required:
Professional, Premium, or Ultimate (for Visual Studio 2012)
Professional, Premium, Ultimate or Community Edition (for Visual Studio 2013)
Professional, Enterprise or Community Edition (for Visual Studio 2015)
If there is no Visual Studio installed on your machine, the setup file for Visual COBOL for Visual Studio
2012 or 2013 will install the Visual Studio Integrated Shell.
Important:
•

A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Visual COBOL for Visual Studio 2013.

•

Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.
Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).
These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.
As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:
•
•
•

12

Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.
Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956
Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.
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•
•

Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

Visual COBOL for Visual Studio 2015 does not support Visual Studio 2015 Shell as the Shell has a
number of restrictions to COBOL development. The Visual Studio 2015 Shell is not included in the
setup for Visual COBOL for Visual Studio 2015 and before you start the installation, ensure that
there is an advanced edition of Visual Studio 2015 installed on your machine.

Note:
•

•
•

On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the
Microsoft Download Center.
Microsoft Visual Studio Express Edition is not supported.
You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If you
choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.
Note that some Visual Studio features might not be available with the Shell. This includes WCF or
the Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for
more details.

The following software is also required:
•
•
•
•

Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.
Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.
Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.
Microsoft .NET Framework 4.6. This is included with Visual Studio 2015.

Visual COBOL and Enterprise Developer for Eclipse:
The following requirements apply to both Visual COBOL and Enterprise Developer:
•

The setup file installs Visual COBOL and Eclipse 4.4.2.

•

See Installing Visual COBOL into other instances of Eclipse for instructions on how to install Visual
COBOL into other instances of Eclipse installed on your machine.
Visual COBOL does not support the 64-bit Eclipse. You can, however, use the 32-bit Eclipse to create
both 32-bit and 64-bit applications.
Visual COBOL requires a 32-bit Java installation.

•

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
•

•

Oracle's Java Platform, Enterprise Edition (Java EE) Java 7 or Java 8 is required to execute COBOL
JVM code and for native COBOL and Java interoperability. You can download Oracle's Java EE from
Oracle's web site and install it anywhere on your machine.
Note: If Java 7 is installed on your machine, to skip installing Java 8, run the Setup file with the
skipjre=1 command line option.
The setup file also installs .NET Framework v4.5.2 and the Microsoft Visual C++ 2010 and 2012
Redistributables.

Installation Restrictions and Requirements
Before starting the installation you should be aware of the following:
•
•

Visual COBOL and COBOL Server cannot coexist on the same machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.
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•

•

•

•
•

•

If, when you install Visual COBOL for Visual Studio , the machine does not have Microsoft Visual C++
Redistributable Runtime already installed, it is installed as required by Visual COBOL. The installation of
Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital signatures,
into the winsxs directory.
If, when you install Visual COBOL for Visual Studio 2013, the machine does not have Microsoft Visual C
++ 2012 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The
installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital
signatures, into the winsxs directory.
You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.
If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.
You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.
Before installing this product , make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:
1. Stop the service, using either the Windows Service Management Console GUI or from a command
line prompt by typing: net stop mf_ccitcp2 Only one instance of the MFDS or CCITCP2
service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.
For MFDS, from a command line prompt enter: mfds -u
For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:
1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:
a. Open a Visual COBOL command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2
Note: The two versions use different paths for environment and registry values, so the list of
configured Enterprise Servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.
MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.
It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Downloading the Products
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

14

| Micro Focus Academic Program 2.3 Update 1 - Release Notes

Installing the Products
Use the individual setup files to install each product from the Micro Focus Academic Program package as
follows:
Windows
1. Run the productname.exe file and follow the wizard instructions to complete the installation.

After Installing
Visual COBOL and Enterprise Developer for Visual Studio
You are now ready to run Visual COBOL or Enterprise Developer. From the Windows taskbar click Start >
All Programs > Micro Focus Product Name > Product Name for Visual Studio. (The Start menu is not
available on Windows 8, Windows 10, and Windows Server 2012. You use the Start screen to invoke
programs.)
Refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.
•

To view the help in Visual Studio 2012, ensure that the Visual Studio Help Library is pointing to local
help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help Browser.

Visual COBOL and Enterprise Developer for Eclipse
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:
1. Open the existing workspace with this product.
2.
3.
4.
5.

You may receive some warnings or errors which you can ignore.
Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
Click Window > Reset Perspective.
Click OK.
Reapply any customizations.

Installing X Windows on Windows
Some features of Visual COBOL for Eclipse and Enterprise Developer for Eclipse on Windows require an X
Windows installation, so Micro Focus ViewNowX is provided with the product. To install, run the file
ViewNow_X_Server.exe in your Visual COBOL installation. By default this will be in the
%ProgramFiles(x86)%\Micro Focus\Visual COBOL for Visual Studio 2012\ViewNowX
folder.
ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
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1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
Note: The installer creates separate installations for Visual COBOL, Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Visual COBOL does not
automatically uninstall Enterprise Server for .NET, the Micro Focus License Manager or any of the
prerequisite software.
Enterprise Server for .NET must be uninstalled before you remove Visual COBOL. To completely
remove the product you must uninstall the Micro Focus License Manager as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
Some registry entries are not removed by the uninstallation process and you need to manually delete
them.
The following folders might not be removed:
•
•
•
•

Micro Focus Product Name folder in the Start menu - you can delete it manually.
%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.
%ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
%Program Files%\Micro Focus - you can delete it manually.

Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.
Micro Focus is a registered trademark.
Copyright © Micro Focus 1984-2016. All rights reserved.
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